z/OSMF labs:
A smorgasbord of goodies to try out!

Using the z/0S Installation Strategy
to:
1. Role of the Software Vendor: define [RANEREIESEN
a Portable Software Instance Technical University
. Role of the Customer: install a
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Abstract:

You hopefully have heard about the z/OS Installation Strategy? This is an undertaking that is
across the entire z/OS industry (with strong participation from both IBM and ISVs) to provide a
common installation and packaging method that you use from z/OSMF.

First, imagine you work for Kitty Corp, and you have a fabulous new product that you want to
package for your awaiting customers. How do you do that today following the z/OS Installation
Strategy with zZOSMF? It's easy, and this lab can help you do just that by packaging the product
into what is known as a z/OSMF Software Management Portable Software Instance (PSI, for
short).

In order to show the most flexibility in the type of products that you can package, this lab will show
how to create a PSI composed of one SMP/E-packaged and installed FMID and one product that
is not SMP/E-packaged at all!

o The SMP/E-packaged product is a fictitious FMID called HMLW100.

¢ The non-SMP/E packaged product is simply a collection of data sets. It just so happens
that we have a very good real-life example of a non-SMP/E packaged product: the z/OS
Cloud Data Access Beta product.

Next, change sides in this scenario. Imagine that you are a customer and have purchased this
wonderful product from Kitty Corp and want to install it on your system. How do you that today,
once you have received the product’s Portable Software Instance from Kitty Corp?
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Exercises Guide

This self-directed lab will take you through each step needed to create that PSI (from the point of
view of a z/OS software vendor), and then how to install that PSI (from the point of view of a z/OS
customer).

What level of zZOSMF do you need to package or install a PSI? Ensure you have the appropriate
z/OSMF Software Management support installed:

e 7z/OSMF V2.2 with PTF Ul44516 , or
e 7z/OSMF V2.1 with PTF Ul42018

What exactly are we packaging into a PSI for this lab?

This imaginary product we are packaging is two very different “elements” to show the power of this
new z/OS Installation Strategy, and how any z/OS software manufacturer can use it, and how a
customer can handle all types of z/OS products. Here’s the details on what composes our lab’s
PSI:

1. A beta product called z/OS Cloud Data Access Beta. This beta product contains the
following six data sets which can be found on the lab system:

MWALLE.PSI.CDA.H

MWALLE.PSI.CDA.LINK

MWALLE.PSI.CDA.LPA

MWALLE.PSI.CDA.PANELS

MWALLE.PSI.CDA.PDSE.LOAD

f. MWALLE.PSI.CDA.REXX

2. Animaginary SMP/E-packaged product (FMID HMLW100) that is already SMP/E applied and
ACCEPTed into an SMP/E CSI. This is to show that you could provide any preinstalled FMID
you wanted, and include all the SMP/E information also into a PSl.including the SMP/E CSiI!
Of course, if you wanted to ship the uninstalled FMID (SMPMCS and RELFILES), that would
be fine too, but that’'s not what we showing. This preinstalled SMP/E-packaged product can be
found in the lab system in the following data sets:

MWALLE.PSI.AMLWHFS : dlib data set associated with the product.

MWALLE.PSI.CSI  : CSI data set from the install

MWALLE.PSI.SMPLTS : associated SMPLTS

MWALLE.PSI.SMPMTS : associated SMPMTS

MWALLE.PSI.SMPPTS : associated SMPPTS

MWALLE.PSI.SMPSCDS : associated SMPSCDS

MWALLE.PSI.SMPSTS : associated SMPSTS

MWALLE.PSI.ZFS  : file system where the product is installed.
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When you follow this self-directed lab, here is a high level overview of what you will learn:

1. Logon to z/OSMF with your supplied lab id and password.

2. z/OS Software view: package a composite product into a Portable Software Instance
(PSI).

3. z/OS Customer view: install a PSI provided from a software vendor using z/ OSMF

Software Management’s deployment task.

If you want to only do half of the lab (either #2 or #3) that is fine. You can jump in wherever you
want, based on your interest.

However, if you want to understand well what is in a PSI and how to get one installed (deployed)
both steps #2 and #3 are the best way to do that.
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Exercises Guide

1. Logon to z/OSMF.

In this step, we will now go into zZOSMF to use the Software Management function. For this lab,
we are using a zZ/OSMF V2.2 system.

a. Go to https://mvsl.centers.ihost.com/zosmf/ on the Firefox or IE web browser

b. Using the userid you were given (SHARANnn, SHARBNN, or SHARCnn) and the password,
logon to z/OSMF. The userid you were given is a regular z/OS userid on this system, and has
been given access to zZOSMF. There is no zZOSMF code on this workstation, all executables
(except the web browser) is on the z/OS system. The lab will show the usage of userid
MWALLE.

c. Click on “Login”. (Do not click on “Use Aesktop interface”, to match this handout.

https://mvs1.centers.ihost.com/zosmf/ #1a ~ § Certificateerror €| | Search.. P~
2 1BM 2o mmrrgermem —
KR 18mz0s Management Faciliy LEARN MORE  NEED HELP?
Hello World!
Welcome to z/0S

The highly secure, scalable and resilient enterprise
operating system for the IBM z Systems mainframe.

Z/0S USERID

sharinn

#1b

20§ PASSWORD

9

[] Use desktop interface @

#1c



https://mvs1.centers.ihost.com/zosmf/

d. Click on “Software”, to untwist the choices, then “Software Management” to launch the

function.

e. You can click on the “close” arrow head (in the red circle) below to show Software
Management as the full screen.

E'-, E\ IBM z/05 Management Facility

Welcome
Notifications
Workflow Editor
Workflows

-

Configuration

-

Consoles

-

Jobs and Resources

-

Links

b Performance

-

Problem Determination
= Soffware
Software Management
¢ zi05 Classic Interfaces
b zZIDSMF Settings

Refresh

o

WWelcome Software Manage...

Software Management
Use this task to view details about your software inventory, including relsted products, festures, FMID=, dsta sets, deplo

Software Instances Define your software to z/OSMF; deploy software; generate reports about your softa
Paortable Software Instances Define your portable software instances to z/OSMF.

Products. ‘iew a consolidated list of the products included in each software instance.
Dieployments Deploy 8 soffware instance, and manage existing deployments.

Create new categories for your software instances and deployments, and manages e
Select the time zone in which to display date and time dats. Indicate whether to disp

© Copyright IBM Corp.2019

Materials may not be reproduced in whole or in part
without the prior written permission of IBM.



Exercises Guide

Role of the Software Vendor: define a Portable Software Instance

First, let’'s see how anyone, including z/OS software vendor could provide the product we
described before. There are two portions of defining a Portable Software instance:

1) Creating a Software Instance, and

2) Taking that Software Instance and making it (“exporting”) a Portable Software Instance.

We will now go through the creation of a Software Instance.

a. Go into the Software Instance option.

IBM z/OS Management Facility Welcome  mwalle -

Welcome Software Manage...

Software Management

Use this task to view details about your software inventory, including related products. features, FMIDs, data sets, deployments. and SYSMODs. Learn more...

Software Instances Define your software to ZZOSMF; deploy software. generate reports about your software.

Portable Software Instances Define your portable software instances to Z/OSMF.

Products View a consolidated list of the products included in each software instance.

Deployments Deploy a software instance, and manage existing deployments.

Categories Create new categories for your software instances and deployments, and manage existing categories.

Settings Select the time zone in which to display date and time data. Indicate whether to display or suppress information messages.

b. You will probably see many Software Instance already on the system. You want to create
a new one. Click on Actions-> Add.

IBM z/OS Management Facility ‘Welcome mwalle ~
Welcome Software Manage...
Software Management » Software Instances Help
Soi e Instances
Switch To: >
‘ { Actions ~
Messages Description Activity Global Zone CSI Target Zones cat
Filter Filter Filter Filter Filter Filt
Source Software Instance for the ZOSMF.SWDEPLOY.GLOBALCSI | TSMP36P i
ZOSMF Software Deployment
Lab. This instance contains the
SMPIE V3.6 product with PTFs
Source Software Instance for the ZOSMF.SWDEPLOY.GLOBALCS| | TSMP36 =
Z/OSMF Software Deployment
Lab. This instance contains the
SMP/E V2.6 product without any
PTF:
Deselect All °
Configure Columns.__ Source Software Instance for the ZOSMF.SWDEPLOY.GLOBAL.CSI | TGTZ12
Z/OSMF Software Deployment
Hide Filter Row Lab. This instance contains z/0S
VIR12 atRSU1105
Export Table Data o 1zubsoal Completed demo software £ Being exported ZOSMF SWDEPLOYGLOBAL CSI | TSMP36N
Print Table Data R | instance. of SMP/E V3.6 with he
« 1 »
Total: 6 Selected: o
Refresh Last refresh: Jul 27, 2017, 7:26:43 PM
Close




c. Now, we have to provide some details for our Software Instance. You can see the mini-
wizard on the left; the steps we need to go through. Provide the following information:

i.  Name : use the userid you are logged onto z/OSMF with, and -PSI-V1R1. For
instance, if you were logged on with SHARC19, your Name would be SHARC19-
PSI-V1R1. We are putting the V1R1 to indicate the release level of this product.

ii. Description : give whatever description you like, to describe this product (Software
Instance).

iii. Click Next> to continue.

IBM z/OS Management Facility

Welcome Software Manage...

Software Management » Software Instances » Add Software Instance

Add Software Instance

Welcome Name and Description

MName and

Description Enter the name and description of the software instance.

System and Global
Zone
Categories

Mon-SMP/E Managed

* Name:
MWALLE-PSI-W1 R1|

Data Sets
Summary Description: (maximum 256 characters, currently 74 characters)
MWALLE's Portable Software Instance to show the
3 z/08 Installation Strategy
< Back Next = Finish Cancel
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d. This is where you say what system contains the contents of your Software Instance.

f.

We are using the same system we are logged onto for this lab, so select LOCAL from
the System pull-down.

We need to add the name of the SMP/E CSI we have installed into. Everyone has to
enter MWALLE.PSI.CSI here, because that is where the SMP/E-installed portion of our
product has been installed for this lab. All lab user IDs have read access to this data
set.

Continue on with Next>.

IBM =/OS Management Facility

wWelcome Software Manage...

Software Management Software Instances Add Software Instance
Add Software Instance

Welcome System and Global Zone

Mame and

Description Select the system and the global zone CS| associated with the product set. If the software instance

Zone.
System and Global
Zone
Categories
= System:
Mon-SMP/E Managed
Data Sets LOCAL - Select...

Summary

* Global Zone CSl (Learn more.. )
MWALLE PSILCSI -

= Back Next > Finish Cancel




g. This is where you can say which zones you what of the CSI. We want to include all the
zones, so select the box next to Target.
h. Then click Next> .

IBM z/OS Management Facility

Welcome Software Manage...

Software Management » Software Instances » Add Software Instance
Add Software Instance

Welcome Target Zones
Name and Select the target zones that describe the target libraries associated with the product set
Description g 9 p .
System and Global
Zone
Target Zones

Target Zones

Categories
Actions -
Mon-SMP/E Managed
Data Sets =+ No filter applied
Summary
Mame Description Messages Related CS5l Data Set
v Filter Filter Filter DLIB Zone | Filter
Filter
v TARGET DLIB MWALLE PSIL.CSI
< | Il
Total: 1 Selected: 1
Refresh Last refresh: Jul 27, 2017, 7:50:11 PM local time (Jul 27, 2017, 11:50:11 PM GMT)
< Back Next > Finish Cancel
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i. The next screen is for a Category, if we wanted to specify one. We aren’t going to use
a Category for this lab, just click on Next>.

IBM =fOS Management Facility

Welcome Software Manage...

Software Management

Software Instances Add Software Instance

Add Software Instance

Welcome

Mame and
Description

System and Global
Zone

Target Zones
Categories

Mon-SMP/E Managed
Data Sets

Summary

Categories

A category is a string or label used to organize and group software instances and deploymenis. A category miglr
software life cycle state, business function., or geographic location. Select one or more categories to assign to th

Categories

Actions -~

=+ No filter applied

Name Description Activity Last Modified (Local)
Filter Filter Filter Filter

There is no data to display.

Total: o Selected: o

Refresh Last refresh: Jul 27, 2017, 7:51:52 PM local time (Jul 27, 2017, 11:51:52 PM GMT)

= Back Next > Finish Cancel
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j. Now, we get to the part we have to add the non-SMP/E product to our Software Instance.
Click on Actions, then, Add.

IBM z/OS Management Facility

Welcome Scftware Manage...
Software Management » Sofiware Instances » Add Software Instance Help
Add Software Instance

Welcome Non-SMP/E Managed Data Sets

gi?;la:gn Z/OSMF automatically includes a data set in the software instance if it is updated by SMP/E and is associated with the software in the software instance. If you have

P a data set that is not updated by SMP/E but is associated with the software in the software instance, such as a procedure liorary, configuration file, or vendor
System and Global product, use the Add action to explicitly add it to the software instance.
Zone

Target Zones

Data Sets
Categories
Non-SMP/E
Managed Data Sets
Summary
e Volume
Filter
v| Select All
Deselect All
Hide Filter Row There is no data to display.
Export Table Data »
Print Table Data  »
Total: o Selected: o
< Back Next > Finish Cancel
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k. We need to add the location of all the z/OS Cloud Data Access Beta data sets. We
know from the description of this lab, that all these six data sets start with

MWALLE.PSI.CDA . Type MWALLE.PSI.CDA in the Data Set Qualifier field and then
Search.

Then wait a minute or two for the system to find them...

IBM z/OS Management Facility Welcome  mwalle

Welcome Software Manage...

Software Management » Software Instances » Add Software Instance » Add Data Set
Add Data Set

To identify the data sets to be added to the software instance, specify a data set name qualifier, volume, or both, and click Search. Then, select the data sets you want 1
name qualifiers, select Learn more._..
Data set name qualifier: Volume: *Maximum data sets:

MWALLE PSI.CDA Select or type - 730 = Search

Select Data Sets to Add

Actions =

+

*+ Nofilter applied

Data Set Name Volume
Filter Filter

There is no data to display.

Total: o Selected: o

OK Cancel
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[.  This is what is returned. How convenient! Our six data sets for the z/OS Cloud Data
Access Beta are found. Now, select all six by clicking on the box next to Data Set
Name (to select all them), or you could just click six times next to each data set. For
some reason, if you didn’t want to include a data set in the Software Instance, you just
wouldn’t click it here.

m. Click OK.

IBM z/OS Management Facility Welcome  mwalle -

Welcome Software Manage...

Software Management » Software Instances » Add Software Instance » Add Data Set

Add Data Set

To identify the data sets to be added fo the sofiware instance, specify a data set name qualifier, volume, or both, and click Search. Then, select the data sets you want
name gualifiers, select Learn more...
Data set name qualifier: Volume: *Maximum data sets:

MWALLE.PSI.CDA Select or type - 750 = Search

Select Data Sets to Add
Actions

%% Nofilter applied

¥ | Data SetName Volume
Filter Filter
¥ MWALLE PSI.CDAH SHRO03
¥ MWALLE PSI.CDALINK SHRO03
¥ MWALLE.PSI.CDALPA SHRO01
¥ MWALLE PSI.CDAPANELS SHRO03
¥ MWALLE PSI.CDAPDSE.LOAD SHROO01
¥ MWALLE.PSI.CDAREXX SHROO5

Total: 6 Selected: 6

oK Cancel
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Then click on Next> to move along, after confirming that your six data sets are shown:

IBM z/OS Management Facility

Welcome Software Manage...

Software Management » Software Instances » Add Software Instance

Add Software Instance

Welcome

Name and
Description

System and Global
Zone

Target Zones
Categories

Non-SMP/E
Managed Data Sets

Summary

Non-SMP/E Managed Data Sets

Z/OSMF automatically includes a data set in the software instance if it is updated by SMP/E and is associz
a data set that is not updated by SMP/E but is associated with the software in the software instance, such

product, use the Add action to explicitly add it to the software instance.

Data Sets

Actions -
J= No filter applied

|—| Name
— Filter

[ ] MWALLE.PSI.CDAH

[ | MWALLEPSL.CDALINK

|| MWALLE PSI.CDA.LPA

[ | MWALLE PSIL.CDAPANELS
] MWALLE PSI.CDAPDSE.LOAD

[ MWALLE.PSI.CDAREXX

Total: 6 Selected: o

< Back Next > Finish

Volume
Filter

Cancel
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We are almost done packaging up our Software Instance... This screen summarizes the
contents of our package. You can browse through it. You'll see the SMP/E portion of our
product (only the Global CSI), and the non-SMP/E portion of our product (the six data sets
we added). Click Finish and we are done!

IBM z/OS Management Facility

Welcome Software Manage...

Software Management Software Instances » Add Software Instance

Add Software Instance

Welcome

Name and
Description

System and Global
Zone

Target Zones
Categories

Non-SMP/E Managed
Data Sets

Summary

Summary

Review your selections. To make changes, return to the appropriate page by clicking Back. When you

Name:
MWALLE-PSI-VIR1

Global Zone CS| Data Set:

MWALLE.PSI.CSI on system LOCAL

Target Zones:

Categories:

< Back Next > Finish Cancel

e — 1

It might take a moment to finish, but you should see this when it is complete:

Software Management » Software Instances

Software Instances

vMessages €3 0 ¢ 0 1

ki The product, feature, and FMID information for software instance "MWALLE-PSI-VIR1" on system "LOCAL" was retrieved. 1ZUD1641  Jul 27, 2017, 8:11:08 PM

© Copyright IBM Corp.2019
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Let’s recap: we packaged a product into a Software Instance that contained the contents we
desired. This isn’t new, and creating Software Instances is a very old function in zZOSMF Software
Management. Now, let’s get to the newer part specifically...taking that Software Instance and
making it a Portable Software Instance (PSI).

We need to make the PSI so that we can distribute it to our paying customers and they can use
this great new product our company (Kitty Corp) has produced.

The PSl is a package that can be acquired by our paying customers, and stored into zZ OSMF for
installation. Creating a PSl is very easy, once you’ve got your Software Instance defined!

On the Software Instances main screen (where all the system’s Software Instances have been
defined), select your Software Instance (called something like SHARC15-PSI-V1R1), and then
Actions -> Export as Portable Software Instance.

Eile Edit View History Bookmarks Tools Help | S Wy .
— = —————
% yourlBM x | oEv IBM Customer Connect - Vi... * W IBM z/OS Management Fa... = +

(- D@ ntt ps://mvsl.centers.ihost.com/zosmf/ 0% ﬂ C Q, search * E ' ‘ﬁ' =
IBM Conf zZOSMF Personal Bookmarks bar Podcast Publishing zOSMF Bookmarks IBM Imported From Firefox @ Bookmarks £ Most Visited =
IBM z/OS Management Facility Welcome mwalle -

Welcome Scftware Manage...
Software Management » Software Instances Help

Software Instances

Switch To: hd
i Actions ~
View »
Modify
Copy Messages Description Activity Global Zone CSI Target Zones Cat
i Filter Filter Filter Filter Filter Filt
e Open Deployments
Export as Portable Software Instance
1 Ldu. 1TSS NSENCE COTlEins 4us P
L Remove.. V1R12 atRSU1105
f on
| @ 1zupaoal Completed demo software 41 Being exported ZOSMF.SWDEPLOY.GLOBALCSI  TSMP26N
Maintenance Reports * instance, of SMP/E V3.6 with
Add PTFs.
205 V113 with over 20 other SMLABO1.GLOBAL.CSI COB320T, DTO10T,
products to be used during the PLI410T, Z1130T
] Select All 2/OSWF Software Management
Deselect All Lab
Configure Columns.... JustatestioraPSlforthe SHARE L) Being exported  ZOSMESWDEPLOYGLOBALCSI  TSMP38

m

Hide Filter Row

1 MWALLE's Portable Software MWALLE PSI.CSI TARGET
Instance to show the 2105
Bxport Table Data : Installation Strategy I
Print Table Data 3

e —— b

Total: 7 Selected: 1

Refresh Last refresh: Jul 27, 2017, 8:29:15 PM

Close
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You need to provide some information. Say:

e Yes, for exporting the distribution zones and libraries. We definitely want our customers to

have all the complete SMP/E installation information.
¢ alocation where the PSI will be stored. This location will be filled in by default, however
that default will not work on our lab system. Change the UNIX directory to be

/sharelab/sharc15/SHARC15-PSI-V1R1 , updating the purple part with the lower case of

your assigned userid. This is case sensitive.

e The JCL data set name default should be fine. This is the location where the export JCL
will be saved, in case you want to see it later.

o Click Next>.

Software Management » Software Instances » Export as Portable Software Instance

Export as Portable Software Instance

Export Properties Export Properties
Review ) ) ) )

Specify the properties used for the export to a portable software instance of the selected software instance.
Export Jobs

System:
LOCAL

Do you want the export to copy the distribution zones and libraries associated with the source software?
® Yes
) Mo

# UNIX directory:
J/shareuser/mwalle/MWALLE-PSI-VIR1

* JCL data set name:

MWALLE.DM.D170727.T203243.CNTL

* JOB statement:

—_———t————]————pee e e B e e e e e e e e e T =

//MHALLEP1 JOB (ACCOUNT), 'NAME'
I
£

< Back Next > Save Finish Cancel

Retrieving information about the data sets included in the selected software instance. This request might take several minutes to complete.
« | 1%

Cancel
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You should then see several review tabs. Click through each one...this is what will be put into
your PSI. You can see that there is both SMP/E information, and non-SMP/E information
included. We've even got a z/OS UNIX file system to include (from the SMP/E FMID). Just what
we wanted! Notice, PSls can be any type of data set: file system, VSAM, PDS, PDSE, sequential

Click Next>.

IBM z/OS Management Facility Welcome mwalle -

Welcome Software Manage...

Software Management » Software Instances » Export as Portable Software Instance

Export as Portable Software Instance

Export Properties Review

Review Review the summary of the contents for the software instance that will be exported.

Export Jobs

SMP/E Zones SMP/E Managed Data Sets SMP/E Managed UNIX Data Sets MNon-SMP/E Managed Data Sels

Global Zone CSI Data Set:  MWALLE PSI.CSI on system LOCAL
Zones to Export

Actions -

+

% Nofilter applied

Zone Name Data Set Hame Type
Filter Filter Filter
TARGET MWALLE.PSI1.CSI TARGET
DLIB MWALLE.PSI.CSI DLIB

< Back Next > Save Finish Cancel
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You can now see the JCL that will do the export to the PSI. You can browse it if you like, by

clicking on the blue job name:

JCL data set name:  MWALLE DM.D170727.T203243.CNTL
System: LOCAL

Jobs

Actions ~

‘s Nofilter applied

Sequence | JCL Data Set Member | Description

v Filter Name Filter
Filter
v o1 IZUDDEX

Export Software Instance: Create portable archives for each data set
in the software instance.

System
Filter

LOCAL

Then select it by clicking on the box on the left, and do Actions -> Submit job.

v Messages €9 0 & 0 f§ 1

Status
Filter

4 Job "IZUDO1EX" ( JOB17100) has been submitted.

1IZUD786I Jul 27, 2017, 8:4319 PM
JCL data set name:  MWALLE.DM.D170727.T203243.CNTL
System: LOCAL
Jobs
Actions ~
i Nofilter applied
__ Sequence JCL Data Set Member = Description System Status
[ ] Filter Name Filter Filter Filter
Filter
—{ 4 | 11
iTi 1 , 1ZUDUTEX Export Software Instance: Create portable archives for each data set | LUCAL & Submitted
ofal: 1 Selected: o in the software instance.
Refresh Last refresh: Jul 27, 2017, 8:40:51 PM local time (Jul 28, 2017, 12:40:51 AM GMT)
< Back Next > Save Finish Cancel
Give it a couple of minutes to run, and then you should see:
Jobs
Actions ~
1+ Nofilter applied
quence JCL Data Set Description System Status Messages
Der Member Name Fitter Fiter Fitter Fitter
Fitter
|:| [FUDDEX Export Software Instance: Create portable archives for each data LOCAL ﬂ Complete
set in the software instance.

Click on Finish and you are done! You now have a PSI that you can sell to any happy customer
in your UNIX file system /sharelab/userid/USERID-PSI-V1R1 ! Remember that location for the

next part of the lab...
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What happens now, to get the PSI to a paying customer?
The PSl is in the file system into a zipped format that zZ OSMF Software Management can

understand. (It happens to be the GIMZIP format from SMP/E, but that is hot something that is of

concern here. Customers might not even be aware of that.) What is important that is that a z/OS

software vendor can take that format and send it to a customer for installation. There are a couple
of ways to do that:

One is to use the GIMGTPKG service routine, and it is probably the simplest, so Kitty Corp.

sets up a download server and provides JCL like this for customers to run:
//job JOB ...
//GOGETIT EXEC PGM=GIMGTPKG
//SMPOUT DD SYSOUT=*
//SYSPRINT DD SYSOUT=*
//SMPNTS DD PATH='/u/usr0l/pkgs/’,PATHDISP=KEEP
//SMPCPATH DD PATH='/usr/lpp/smp/classes/’,PATHDISP=KEEP
//SMPJHOME DD PATH='/usr/lpp/java/J6.0/’,PATHDISP=KEEP
//SMPSRVR DD *
<SERVER host="host.sample.com"
user="usr01l"
pw="n0Opeekng">
<PACKAGE file="CBPROC/012345/RIMTAPE/GIMPAF .XML"
hash="1234567890123456789012345678901234567890"
id="012345">
</PACKAGE>
</SERVER>
/*
//SMPCLNT DD *
<CLIENT retry="3">
</CLIENT>
/*
Another way is to perhaps use the pax utility to put it into a single MVS data set, such as:
//PAXITUP EXEC PGM=IKJEFTO01l,REGION=0K
//SYSPROC DD DSN=SYS1.SBPXEXEC, DISP=SHR

//SYSTSPRT DD DSN=&&HFSOUT,

// DISP= (NEW, PASS, DELETE) , SPACE=(TRK, (10,10)),

// DCB= (RECFM=FB, LRECL=121, BLKSIZE=12100)

//SYSTSIN DD *
oshell cd /KittyCorp/PSI-VIR1/ && +
pax -wzvf "//'PSIVIR1.ARCHIVE" *

//*

What is probably a very likely scenario is the following:

1.

2.

4.

Kitty Corp. uses a utility (such as z/OS UNIX pax) to create an archive of that PSI in the file
system. This will put it in a single file.

With fabulous advertising, the customers decide they want that PSI. The customers can
FTP the PSI from the Kitty Corp to their own system, into a z/OS UNIX file location. How
they transfer that single file from one place to another is a decision that vendor would take,
but conceptually, think that FTP could be one method to get it from Kitty Corp to the
customer.

Now that the customer has acquired the PSI from Kitty Corp...they unload the archive into
the z/OS UNIX file system (perhaps using the z/OS UNIX pax command to un-archive it
into several files in a directory).

The PSl is in the z/OS UNIX file system on z/OS and is ready for zZOSMF to install it.

Let’s now see how that installation is done by a customer...
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3.Role of the Customer: install a Portable
Software Instance

So, you’ve bought a great new product from Kitty Corp! You’ve acquired the file (somehow,
possibly via GIMGTPKG), and if necessary also un-archived it into your z/OS UNIX file system (if
you received it as a single pax archive file). What's next? A very simple deployment with zZ OSMF
Software Management.

Ensure that you are on the primary Software Management screen, and select Portable Software
Instances

Welcome Software Manage...

Software Management

Use this task to view details about your software inventary, including related products, features, FMIDs, data sets, deployments, and SYSMODs. Learn more...

Software Instances Define your software to 20SMF; deploy software; generate reports about your software.

Paortable Software Instances Define your portable software instances to ZOSMF.

Products View a consolidated list of the products included in each software instance.

Deployments Deploy a software instance, and manage existing deployments.

Categories Create new categories for your software instances and deployments, and manage existing categories.

Settings Selectthe time zone in which to display date and time data. Indicate whether to display or suppress information messages.

This is where all the Portable Software Instances (PSI) on this system can be found.

e If you are doing this lab from only the customer view and jumping into the middle of this lab,
then your z/OS UNIX location will be /shareuser/MWALLE/MWALLE-PSI-V1R1 . Remember
that name.

e |f you are doing this lab from the beginning (both the ISV and the customer view), then your
z/OS UNIX location will be /sharelab/your_userid/YOUR_USERID -PSI-V1R1 . Where
your_userid is your assigned userid, such as SHARC15. The name is case sensitive, so
make sure you have the name in the correct case in both your_userid locations. Remember
that name.
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You know where you PSI has been stored (from one of the bullets above). Go to Actions -> Add.
You are going to add your PSI to the inventory for installing.

IBM zZ/OS Management Facility Welcome mwalle -~

Welcome Software Manage...

Software Management Poriable Software Instances Help

Portable Software Instances
Switch To: =
{ Actions ~

sription Activity System File Location Categories
Filter Filter Filter Filter

H Add.__
~| Select All There is no data to display.

Configure Columns___
Hide Filter Row

Export Table Data »
Print Table Data »

Total: o Selected: o

Refresh Last refresh: Jul 27, 2017, 8:22:07 PM local time (Jul 28, 2017, 12:22:07 AM GMT)

Close

On the next screen, select the System as Local (the only choice on our lab system), and then
provide the z/OS UNIX location where you had your PSI. That is the name that you were to
remember from above. For instance, /sharelab/user_id/USER_ID-PSI-V1R1 or
/shareuser/mwalle/MWALLE-PSI-V1R1

Click on Retrieve.

IBM z/OS5 Management Facility

Welcome Software Manage...

Software Management Fortable Software Instances Add Portable Software Instance

Add Portable Software Instance

= System:
LOCAL - Select...

= File location (LIMIX file):
Ishareuser/mwalle/MWALLE-PSI-V1RA -

Retrieve
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It might take a moment or two:

Retrieving the portable software instance contents from “/shareuser/mwalle/MWALLE-PSI-V1R 1. This request might take several minutes to complete.

| 0%

Cancel

When it has been successfully retrieved, you'll see some information (that you packaged with) in

the PSI. Click on OK.

Welcome Software Manage...

Software Management ¢ Portable Software Instances » Add Portable Software Instance

Add Portable Software Instance
# System:
LOCAL - Select...

* File location (UMIEX file):
Ishareuser/mwalle/MWALLE-PSI-VIR -

Retrieve

= Mame:
MWALLE-PSI-VIRA

Description: (maximum 256 characters, currently 0 characters)
ALLE's Portable Software Instance to show the
z/05 Installation Strategy.

Categories

Actions ~

3+ Nofilter applied

Name Description Activity Last Modified (Local) Modified By
Filter Filter Filter Filter Filter
There is no data to display.
0K Cancel
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Your PSl is ready to be installed!

Software Management » FPortable Software Instances

Portable Software Instances

Actions =

i+ Nofilter applied
Name Description Activity
Filter Fitter Fitter

MWALLE's Portable Software
Instance to show the z/0S
Installation Strategy.

|:| MVWALLE-PSIWV1R1

System
Filter

LOCAL

File Location
Fitter

Categories
Fitter

Ishareuser/mwalle/MWALLE-
PSR

Let’s get the install (deployment) started. On the far right, click on the Switch To: drop down and

select Deplo

ov LU zustir FEDUN DUURITIIRS Udl FUULSL FULISII

IBM z/OS Management Fa

Welcome Software Manage...

Software Management » Poriable Software Instances

Portable Software Instances

Actions ~

= Nofilter applied

D Name Description Activity System
Fitter Fitter Fitter Fitter
D MWALLE-PSFVIRT MWALLF's Portable Software LOCAL

Instance to show the z/0S
Installation Strategy.

ny

File Location
Fitter

LUDVIF DUUKITIEIES.

v

Categories
Fitter

Ishareuser/mwalle/MWALLE-

PSFVIR1

WHPUILEU FIUIT THEIUX T DUURIIDIRY BEF IVIUSL VISILEU

Help

Switch To: .
Software Instances

Porable Software Instances
Products

Deployments

You are now in the Deployment section. You will take the PSI and copy it onto your system. This
Deployment function is rather old in zZOSMF, so you might be familiar with it already. From the

Actions drop-down, select New.

IBM z/0S Management Facility

Welcome Software Manage...

Software Management » Deployments
Deployments

To deploy software, create a new deployment by selecting New or Copy from the Actions menu.

Sription Activity Categories
1 Fiter Fiter
( 45 8 sample dep that Completed
New. ibe used for demos.
| SelectAll
Deselect All

Configure Columns
Hide Filter Row

Export Table Data »
Print Table Data 3

Source Software
Fitter

Source System
Fiter

& MASTER_SMPEV3.6_WTH_PTF LOCAL

Help

Switch To:

Target Software Instance
Fitter

Target System
Fiter

DEMO_SMPEV3 6_WITH_PTFS LOCAL
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You have the mini-wizard for deploying (installing) the software instance. Select the first option,
Specify the properties for this deployment.
Software Management Dieployments Deployment Checklist
Deployment Checklist
To deploy software, complete the checklist.
Checklist
Progress Step
= Specify the properies for this deployment.
Selectthe software to deploy.
Selectthe objective for this deployment.

Configure this deployment.

Define the job settings. ZI0SMF creates the deployment summary and jobs.
= View the deployment summarnry.

Submit deployment jobs.
Specify the properties for the target software instance.

Close

Fill in what you want to call the deployment. Since it’s for Kitty Corp’s Marna V1R1 PSI, that is
decent name, but you have to pick a name that is unique since you can’t have duplication
deployment names. Perhaps put your assigned userid in the deployment name to make it unique.
Click OK. Then progressing through the mini-wizard, select the next step: Select the software to

deploy.

Welcome Software Manage...

Software Management » Deployments » Deployment Checklist » Specify Deployment Properties
Specify Deployment Properties

Enter a name and optional description for this deployment.

= Mame:
KittyCorpMarna'1R1

Description: (maximum 256 characters, currently 54 characters)

The installation of Kitty Corp. product Marna at
W1R1.

Categories

Actions =
3+ Nofilter applied

Hame Description Activity Last Modified (Local) Modified By | L«
Fitter Fitter Fitter Fitter Fitter Fil

There is no data to display.
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Now this part is new! You want to select the Portable Software Instance you just received from
Kitty Corp (the name you used when you added the Portable Software Instance above!). Then
Select OK to continue. Then proceed with Set the object for this deployment.

Software Management » Deployments » Deployment Checklist » Select Software
Select Software
Selectthe type of software to deploy:

() Software Instance (@ Portable Software Instance
Portable Software Instances
Actions ~

3+ Nofilter applied

Name Description Activity System File Location Categories
Filtter Filtter Fitter Fitter Fitter Filtter
I@J MWALLE-PSFWV1RA1 MWALLE's Portable Software LOCAL Ishareuser/mwalle/MWALLE-
Instance to show the z/0S PSHV1R1

Installation Strateqy.

Total: 1 Selected: i

Refresh Lastrefresh: Jul 28, 2017, 3:55:30 PM local time (Jul 28, 2017, 7:55:30 PM GMT)

You are a customer, and you need to install this PSI. Select that you want to Create a new
software instance, with A new global zone CSI, on your LOCAL system. Then OK. Continue
on by clicking on Check for missing SYSMODs on the mini-wizard.

Welcome Software Manage...

Software Management » Deployments » Deployment Checklist » Select Deployment Objective

Select Deployment Objective

This deployment creates a copy of the source software. The resulting copy is referred to as the target software instance. Indicate whether you wani
software instance.

Objective:
-.’Q‘.- Create a new software instance and connect it to the following global zone CSl. Learn more. ..
@ Anew global zone CSI

() Another existing global zone CSl

-Z:_“.- Replace an existing software instance, and connectthe new instance to the existing instance’s global zone CSI. Learn more...
Select the system where the target software instance will reside.

# Target system:
LOCAL - Select...
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We are going to move through this older function very quickly, since it not unique for PSI
installations. Do note, however, what you are doing at each step during the deployment. Click on
Next.

Software Management » Deployments » Deployment Checklist » Check for Mizsing SYSMODs
Check for Missing SYSMODs

Welcome Welcome
Select Reports

Define Data Set
Settings

Get HOLDDATA

Use this wizard to generate reports that help you identify if you are missing any SYSMODs in your source software or any related software instance.

Summary This wizard guides you through the following steps:

« Selectthe reports to generate, and select the software instances to include.
« Define data set settings.

« Confirm that you received the latest HOLDDATA.

» Review your selections, and generate the reports.

This is where you can run various SMP/E reports to see if any dependencies are missing or
regressions would happen between this software instance and other software instances you
already have. We are going to skip this portion, so uncheck the two boxes, and click on Finish.
Software Management » Deployments » Deployment Checklist » Check for Missing 8YSMODs

Check for Missing SYSMODs

Welcome Select the Reports to Generate
Select R rt
elect Reports Select the reports that you want this wizard to generate.
Define Data Set
Settings
Get HOLDDATA —
Summary |:| Requisite SYSMODs and Fix Categories reports.
The Requisite SYSMODs report will identify potential software compatibility issues (missing SYSMODs) for software instances that will share resource
the dependencies of the target software instance.
Learn more...
The fix categories report will identify missing SYSMODs for the software instance types and fix category combinations listed in the table below.
Learn more...
Fix Categories Checked by Software Instance Type
Software Instance Type Fix Categories to be Checked
Source + |BM.Device *
+ |BM.Function.*
« |BM.TargetSystem-RequiredService *
Shared Resources + |BM.Coexistence.”
« |BM.Migrate-Fallback.*
Satisfies Dependencies « |BM.TargetSystem-RequiredService *
D Regressed SYSMODs and HOLDDATA Delta reports.
The Regressed SYSMODs report will identify the SYSMODs that will be lost, undone, or regressed when you migrate to the target software instance.
Learn more...
The HOLDDATA Delta report will identify the USER and SYSTEM HOLD delta.
Learn more...
< Back Next > Finish Cancel
© Copyright IBM Corp.2019 27

Materials may not be reproduced in whole or in part
without the prior written permission of IBM.



Exercises Guide

We understand that it is not recommended to skip the dependency and regression reports, so click

OK. Then back on the mini-wizard, select the next step: Configure this deployment.
EiE SYa3MODs for the software instance types and fix cate;cr,' combinations listed

i {. You have not selected to generate any of the recommended
== reports. Click OK to exitthe wizard. Otherwise, click Cancel and
select the reports to generate.

[ZUD226W oK Cancel envi

= =
a IRM Minrata_Fallhark *

This is where you can do a lot of customization for how you want this PSI installed! After reading
through all the items that we are going to (briefly) go through, click Next>.

Software Management » Deployments » Deployment Checklist » Configure Deployment

Configure Deployment for MWALLE-P3I-V1R1

> Welcome Welcome
DLIBs - : i
Use this wizard to configure the data set names, catalogs, volumes, mount points, and SMP/E zones to be used for the target software instance.
Model
SMP/E Zones
Data Sets -
Catalogs This wizard guides you through the following steps:
Volumes and Storage 1. Indicate whether this deployment should copy the distribution zones and distribution libraries (DLIBs) that are associated with the source software.
Classes 2. Selectthe software to use as a model for configuring the target software instance.
Mount Points 3. Specify the SMP/E zone names to use.

4. Specify the data set names to use, and assign the data sets to a volume or storage class.

5. Assign each data set prefixto a catalog.

6. Ensure that the volumes and storage classes have enough space to store the target software instance.

7. Specify the mount pointto use for each UNIX file system data set that will be included in the target software instance.

Select Yes because we want to take the DLIBs that Kitty Corp has sent us. Then Next>.

Software Management » Deployments » Deployment Checklist » Configure Deployment

Configure Deployment for MWALLE-PSI-V1R1

v Welcome DLIBs
> DLIBs ) ; L L ) )
Indicate whether you want this deployment to copy the distribution zones and the distribution libraries (DLIBs) that are associated with the source software.
Model
SMP/E Zones
Data Sets —
Catalogs Do you want to copy the distribution zones and libraries associated with the source software?
@ Yes
Volumes and Storage =
Classes () No

Mount Points
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Assuming that this is the first time we’ve ever installed this Kitty Corp product, we are going to
model this deployment on what Kitty Corp sent us. Select The source software, then Next>.

Software Management » Deployments » Deployment Checklist » Configure Deployment

Configure Deployment for MWALLE-PSI-VIR1

v Welcome Model
v DLIBs . .
Select the software to use as a model for configuring the target software instance. 2ZIOSMF uses the data
= Model model to prime the corresponding values for the target software instance.
SMPJ/E Zones
Data Sets -

Selectthe software to use as a maodel.
(@ The source software

Catalogs

Volumes and Storage . o )
Classes i) An existing software instance

Mount Points
Wait just a bit:

#+ Collecting data to prime the target software instance. This request might take several minutes to complete. Note that no changes are occurring on the target system.

Cancel

To show how easy it is to decide your own target and dlib zones names, enter something new
here. Then click Next>.

Software Management » Deployments » Deployment Checklist » Configure Deployment

Configure Deployment for MWALLE-PSI-VIR1

v Welcome SMP/E Zones
./ DLIBs ) ) ) ) )
The Zones table lists the names that will be used for the SMP/E zones included in the target software instance. Acceptthe default names, or modify the values. To modify the

' Model double click an editable cell, or select it and press Enter. To exit an editable cell and preserve your changes, click outside ofthe cell or press Enter.
> SMPIE Zones

Data Sets -

Catalogs Zones

Volumes and Storage Actions =

Classes

Mount Points }’ AYOﬁher apphed

Target Target Zone Target DLIB Zone Messages Source Target Zone Source DLIB Zone
Filter Fitter Fitter Fitter Fitter
NYTARG MYDLB TARGET bLB
© Copyright IBM Corp.2019 29

Materials may not be reproduced in whole or in part
without the prior written permission of IBM.



Exercises Guide

This is where you could spend a lot of time customizing the names and placements of data sets in
your environment. Notice something interesting here: this PSI contains both SMP/E and non-
SMP/E data sets, proving that the PSI doesn’t care what it contains, and can handle both SMP/E

and non-SMP/E data sets just fine. Of course, it doesn’t even need to contain any SMP/E installed
products if the ISV didn’t want to package their product with SMP/E.

Software Management » Deployments » Deployment Checklist

Configure Deployment for MWALLE-PSI-VIR1

Configure Deployment

The Data Sets table lists the names, volumes, and storage classes that will be used for the data sets included in the target softwars instance. Acceptthe default names, volumes, and storage

Welcome Data Sets
DLIBs
Model classes, or use the Modify action to modify them
SWP/E Zones
Data Sets —
Catalogs Data Sets
Actions ~

Volumes and Storage
Classes

Mount Points i Nojilter applied

. Target Data Set Name Target Volume Target Storage Messages
[] Fiter Fiter Class Fitter
Fitter
D MWALLE.PSI.CDAH SHARE
[ WMwWALLE PSIL.CDA LINK SHARE
‘ |] MWALLE.PSI.CDALPA SHARE
|] MWALLE.PSI.CDA.PANELS SHARE
|] MWALLE PSI.CDA PDSE LOAD SHARE
[ MWALLE PSLCDA REXX SHARE
D MWALLE.PSI.CSI TS0
|] MWALLE PSI.SMPLTS TS50
[ WwWALLE PSLSMPHTS TSO
L I e e e
4 1
Total: 12 Selected: o
< Back Next > Finish Cancel

Source Data Set Name

Fitter

MWALLE PSI.CDAH

MWALLE PSI.CDA LINK

MWALLE PSI.CDALPA

MWALLE PSI.CDA.PANELS

MWALLE PSI.CDA PDSE LOAD

WMWALLE PSI.CDA.REXX

MWALLE.PSI.CSI

MWALLE PSI.SMPLTS

MWALLE PSISMPMTS

Source Volumes

Fitter

SHROO3

SHRO0O3

SHROM

SHROO3

SHROO

SHR00S

SHTSD6

SHTS03

SHTSOS

If you wanted to investigate renaming or moving data sets, select the data set(s) and then do
Actions->Modify. To move through this lab quickly, though, we won’t show that. It is pretty
intuitive once you select the data set. Spend time on this option if you like. Click on Next> when

you are done.

| Configure Deployment for MWALLE-PSI-VIR1

Welcome Data Sets
DLIBs
Model classes, or use the Modify action to modify them

SMPIE Zones
Data Sets —

Catalogs E:Ef_ta Sets

Volumes and Storage
Classes

Mount Points

Deselect Al Target Volume Target Storage Messages
I : Filter Class Fitter
Configure Columns.. Fiter
Hide Filter Row
SHARE
l Export Table Data 3 SIS
| i Print Table Data v SHARE
71 MwALLE PSI.CDA PANELS SHARE

Source Data Set Name

Filter

MWALLE.PSL.CDAH

MWALLE PSI.CDA LINK

MWALLE PSLCDA LPA

MWALLE.PSI.CDA.PANELS

Source Volumes

Fitter

SHRO03

SHRO03

SHROO1

SHRO03

The Data Sets table lists the names, volumes, and storage classes that will be used for the data sets included in the target software instance. Acceptthe default names, volumes, and storage

Sourct
Class
Fitter

SHARE *

SHARE

SHARE

SHARE| —

Sourc:
Class
Fitter
SHARE
SHARE
SHARE
SHARE

SHARE

SHARE
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Here is where you would ensure the cataloging is as desired. If you want to investigate, just select
the name, and then Actions -> and what you’d like to do. Click Next> to continue.

Software Management » Deployments » Deployment Checklist » Configure Deployment

Configure Deployment for MWALLE-P SI-V1R1

\Welcome Catalogs
DLIBs . .
The Target Data Set Mame Prefixes table lists the catalogs where target data sets with the data set name prefixes will be cataloged. You can accept the default
Model different catalogs, or select not to catalog the corresponding data sets.
SMPIE Zones
Data Sets -
Catalogs Target Data Set Name Prefixes
Volumes and Storage Actions
Classes

Mount Points s Nofilter applied

Prefix Hew or Existing Catalog the Data  Catalog Name Catalog Type Messages
|:| Fiter Filter Sets? Filter Filter Filter
Fitter
[ mwaLLe Existing ‘Yes (Required) UCATSHTSO USER

Next up is Volumes and Storage Classes. By default (unless you changed it back on the Data
Sets step) this Kitty Corp product will use Storage Classes. You could change volumes or

Storage Classes here if you wanted. Keep going. Click Next>. Then Mount Points to move
along.

Software Management » Deployments » Deployment Checklist » Configure Deployment

Configure Deployment for MWALLE-PSI-V1R1

Welcome Volumes and Storage Classes
DLIBs
The Target Volumes and Target Storage Classes tables listthe volumes or storage classes where each target data set or new user catalog will reside. Accept the default volumes anc
Model classes, or use the Modify action to modify them.
SMP/E Zones
Data Sets -
Volume Total Current Current Messages Allocated Allocated Allocated Planned Initialize Catalog Indirect Catalog
Catalogs Fitter Capacity | Allocated  Allocated  Fiter Space Space Space Threshold (%) Volume Method Entry Symbal
Volumes and [FI'_.:B] [E":gﬁe g_ﬁace (%) gﬂelr gﬂelr E_ilia (MB) Fitter Filter Filter Filter
itter itter eployme Deployme = Fiter
Storage Classes = (1B) %)
Mount Points Fitter Fitter
There is no data to display.
Total: o Selected: o
Target Storage Classes
Actions =
I+ Nofilter applied
Storage Class Space Required
Fitter (MEB)
Filter
O 150 1876
Refresh Lastrefresh: Jul 28, 2017, 4:36:50 PM local time (Jul 28, 2017, 8:36:50 PM GMT)
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We are now at the last configurable change to do for the deployment: Mount Points. Change the
mountpoint here, if you like. Click Finish.

Software Management » Deployments » Deployment Checklist » Configure Deployment

Configure Deployment for MWALLE-PSI-V1IR1

Welcome
DLIBs

Model

SMPIE Zones
Data Sets
Catalogs

Volumes and Storage
Classes

Mount Points

Mount Points

The Mount Points table lists the mount points that will be used for the UNIX file system data sets included in the target software instance. Acceptthe default mount points, or
Mount Point action to modify them.

Mount Points

Actions =
i+ Nofilter applied

— Target mount point Target Data Set Name Source mount point Source Data Set Hame
l—l Filter Fitter Fitter Filter

|:| Ishareuser/mwalle/psi MWALLE PSIZFS Ishareuser/mwalle/psi MWALLE PSLZFS

Back on the Deployment Checklist, we are moving right along. Click on Define the job settings.
Z/OSMF creates the deployment summary and jobs.

The deployment process we just went through will create a series of jobs to run. You can indicate
where you want the jobs stored, and the JOB statement to use. We are not going to really run the

jobs for this lab, so you can click on OK.

Software Management » Deployments ¢ Deployment Checklist

Define Job Settings

To specify the job settings, provide the information requested. Then, click OK to generate the deployment summary and jobs. Tl

= JCL data set name:
MWALLE.DM.D70728 T164559.CNTL

= JOB statement:

__________________ -3 4 4L

//MWALLEE1 JOB (RCCOUNT), 'HAME'
S
S
S

Jobs are created:

3 Creating the deployment summary and jobs. This request might take several minutes to complete.

Cancel

Define Job Settings
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At this point, because we did no customization on the data sets, zZOSMF will tell you there are
already data sets on the system with those names. That is ok, because we are not going to
continue on from here in this lab session.

Finishing up the deployment means running the produced JCL to copy the PSI from the z/OS
UNIX directory onto DASD with the names and locations, and cataloging options you wanted.

When the jobs have been completed, your Kitty Corp product is ready for you to customize and
use!

Clean up

After you've done all the poking around that you like on this deployment, it would be nice of you to
delete your deployment you just made to keep unnecessary deployments cleaned off the system.
Click on your own deployment, then Actions -> Remove. Thank you for being a good user on our
system!

What about using z/OSMF to help with the customization at this point?

Indeed! We would like, once the deployment jobs have been run and have been successful, to
launch into a product-provided Workflow that accompanied the product to help with customization.
That portion, however, is not ready to show in this lab at this time. However, just keep that in mind
when you think about how many parts of zZOSMF can help with your overall install: not just putting
the code in libraries (Software Management deployment), but beyond that with customization
(z/lOSMF Workflow).
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